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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider Windstream using Sonus and Avaya IP Office 8.1.

Windstream SIP Trunking provides PSTN access via a SIP trunk between the enterprise and
the Windstream network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the enterprise.

Windstream is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider Windstream and an Avaya IP Office solution. In the sample
configuration, the Avaya IP Office solution consists of an Avaya IP Office 500v2 Release 8.1,
Avaya embedded Voicemail, Avaya IP Office Softphone, Avaya H.323, Avaya SIP, digital and
analog endpoints.

The Windstream SIP Trunking service referenced within these Application Notes is designed for
business customers. The service enables local and long distance PSTN calling via standards-based
SIP trunks as an alternative to legacy analog or digital trunks, without the need for additional TDM
enterprise gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office
connecting to Windstream using Sonus SIP Trunking service.

This configuration (shown in Figure 1) was used to exercise the features and functionality tests
listed in Section 2.1. Note: NAT devices added between Avaya IP Office and the Windstream
network should be transparent to the SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to Windstream SIP Trunking
service. To verify SIP trunking interoperability, the following features and functionality were
exercised during the interoperability compliance test:

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls to/from the Avaya IP Office Softphone.

e Inbound and outbound long hold time call stability.

e Various call types including: local, long distance, international, inbound toll-free, outbound
toll-free, and 411 services.

e Codec G.711U and G.729A.

e Caller number/ID presentation.
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e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833 or Inband.

e Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Use of SIP re-INVITE for call transfer to PSTN.

FAX using G.711.

Off-net call forwarding (Windstream supports Diversion Header).

Twinning to mobile phones on inbound calls.

2.2. Test Results

Interoperability testing of Windstream SIP Trunking was completed with successful results for all test
cases with the exception of the observations/limitations described below:

e The operator assisted call and 911 services are not available at the current testing.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com

For technical support on the Windstream system, please contact customer service or visit:
http://www.windstream.com/

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Windstream SIP Trunking service through the public IP network. For confidentiality
and privacy purposes, actual public IP addresses used in this testing have been masked out and
replaced with fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office 500v2 with the MOD DGTL STA16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VolP codecs. The voicemail service is embedded on
Avaya IP Office. The LANZ2 port of Avaya IP Office is connected to the public IP network.
Endpoints include an Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya 1408D Digital
Telephones, an Avaya Symphony 2000 Analog Telephone and an Avaya IP Office Softphone
H323/SIP. A separate Windows XP PC runs Avaya IP Office Manager to configure and administer
Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration for Avaya IP Office with Windstream SIP Trunking Service .

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 6 + N digits to
send digits across the SIP trunk to Windstream. The short code of 6 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to Windstream. For calls within the North
American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP
calls, Avaya IP Office would send 11 digits in the Request URI and the To field of an outbound SIP
INVITE message. It was configured to send 10 digits in the From field. For inbound calls,
Windstream SIP Trunking sent 10 digits in the Request URI and the To field of inbound SIP
INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond the
scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the
service provider and the Avaya IP Office must be allowed to pass through these devices.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment Release
Avaya IP Office 500v2 8.1 (43)
Avaya IP Office DIG DCP*16 V2 8.1 (43)
Avaya IP Office Ext Card Phone 8 8.1
Avaya IP Office Manager 10.1 (43)
Avaya 9620L IP Telephone (H.323) 3.1.02S
Avaya 9640G IP Telephone (H.323) 3.1.04S
Avaya Digital Telephones (1408D) N/A
Avaya Symphony 2000 Analog N/A

Telephone
Avaya IP Office Softphone

3.2.3.15 64595

HP Officejet 4500 N/A
Windstream Components
Equipment Release
Sonus switch VV07.03

Note: Testing was performed with IP Office 500 R8.1, but it also applies to IP Office Server Edition
R8.1. Note that IP Office Server Edition requires an Expansion IP Office 500 v2 R8.1 to support
analog or digital endpoints or trunks.

5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to Windstream SIP
Trunking service. Avaya IP Office is configured through the Avaya IP Office Manager PC
application. From a PC running the Avaya IP Office Manager application, select Start - Programs
—> IP Office = Manager to launch the application. Navigate to File > Open Configuration, select
the proper Avaya IP Office system from the pop-up window, and log in with the appropriate
credentials. A management window will appear similar to the one shown in the next section. The
appearance of the IP Office Manager can be customized using the View menu. In the screens
presented in this section, the View menu was configured to show the Navigation pane on the left
side, the Group pane in the center, and the Details pane on the right side. These panes will be
referenced throughout the Avaya IP Office configuration. Proper licensing as well as standard
feature configurations that are not directly related to the interface with the service provider (such as
the LAN interface to the enterprise site and IP Office Softphone support) is assumed to be already in
place.
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5.1. LAN2 Settings

In the sample configuration, the IPOffice_1 was used as the system name and the LAN2 port was
used to connect to Windstream SIP Trunking service. To access the LAN2 settings, first navigate to
System (1) = IPOffice_1 in the Navigation and Group Panes and then navigate to the LAN2->
LAN Settings tab in the Details Pane. Set the IP Address field to the IP address assigned to the
Avaya IP Office LAN port. Set the IP Mask field to the mask used on the public network. All other
parameters should be set according to customer requirements.

IP Offices
R gootP (8) ; Bans = System || LANI DNS | Voicemail | Telephony | Directory Services | System Events | sMTP | SMDR | Twinning | veM | ccR - | Codecs
4 Operator (3 “1POffice_1 -
= #%9|IPOffice 1 LAN Settings | | yoIP | Network Topology | SIP Registrar
=3 t
w[5ystem (1) 1P Address 1010 .98 . 14
17 Line (3)
< Control Unit (4) 1P Mask 255 . 255 . 255 . O
& Extension (29) — -
§ Userizn Primary Trans. IP Address 0 0 0 0 |
&% HuntGroup (1) 7 2
9% short Code (58) Firewall Profile <None> It
@ service (0) RIP Made None &
o RAS (1)
@ Incoming Call Route (5) [] Enable NAT

£ wanPort (0)
n Directory (0)
17 Time Profile (0) DHCP Mode

il O server O Clent O Diin © Diaied

&m Account Code (0)
& License (30)

& Tunnel (0)

£ User Rights (10)
{88 Auto Attendant (0)
“¢ ARS (2)

fx E911 System (1)

Number OF DHCP IP Addresses 200 &/

ok | [ cancel | [ hep
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Select the Vol P tab as shown in the following screen. The H323 Gatekeeper Enable box is checked
to allow the use of Avaya IP Telephones using the H.323 protocol, such as the 9600-Series IP
Telephones used in the sample configuration. The SIP Trunks Enable box must be checked to
enable the configuration of SIP trunks to Windstream. The SIP Registrar Enable box is checked to
allow Avaya IP Office Softphone usage. The RTP Port Number Range can be customized to a
specific range of receive ports for the RTP media. Based on this setting, Avaya IP Office would
request RTP media be sent to a UDP port in the configurable range for calls using LAN2. The
Enable RTCP Monitoring On Port 5005 is checked. Avaya IP Office can also be configured to
mark the Differentiated Services Code Point (DSCP) in the IP Header with specific values to support
Quality of Service policies for both signaling and media. The DSCP field is the value used for media
and the SIG DSCP is the value used for signaling. The specific values used for the compliance test
are shown in the example below. All other parameters should be set according to customer
requirements.

B IPOffice_1 g -8 X | v]<|

System | LAM1 | LANZ | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR | Codecs
LAN Settings ‘NetworkTopnIogy SIP Registrar

H.323 Gatekeeper Enable
SIP Trunks Enable
SIP Registrar Enable

RTP Port Number Range

[] H.323 Auto-create Extn e
Port Range {Minimum}) ‘49152

TR

H.323 Auto-create User Port Range (Maximum) [53246

[[] H.323 Remote Extn Enable

Enable RTCP Monitoring
On Port 5005

DiffServ Settings

B8 3| DsceiHexy FC 3] DSCPMaskiHex) 88 3| S16DSCP (Hex)

46 3| psce B3 2] pscpmask 4 3| si6Dsce

DHCP Settings

Primary Site Specific Option Number (SSON) 176 =

Secondary Site Specific Option Mumber (SSON) 242 5

VLAN ot Present  v|

1100 Yoice YLAN Site Specific Option Number (SSON) 232 e

1100 Yoice YLAN IDs [ v
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Scroll down to the bottom of the screen shown above to RTP Keepalives settings, select Scope as

RTP, enable Initial keepalives and set Periodic timeout 10 second. Enabling this will prevent the
loss of speech path on calls forwarded across the SIP trunk. These settings instruct Avaya IP Office
to sent RTP keepalive packets every 10 seconds from the establishment of the connection. This will
start media flowing from the far-end endpoint in those cases where the far-end endpoint is waiting to
receive media before it starts to send media of its own.

B IPOffice_1 of -8 X | v|
System | LaN1 | LANZ |DNS | Yoicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR | Codecs
LAN Settings | Network Topology | SIP Reqistrar ‘
H.323 Auto-create User Port Range (Maximum) 53246 & Al
[[] H.323 Remote Extn Enable
Enable RTCP Monitoring
On Port 5005
DiffServ Settings
Ba 3| pscr(Hex) [FC ¥ | DSCPMask(Hex) 88 3 | 516 DSCP (Hex)
@6 | psce 63 2| DSCPMask 3 2| siGDsce
DHCP Settings
Primary Site Specific Option Number (SSOM) [176 & |
Secondary Site Specific Option Number (SSON) [242 =
VLAN Mot Present v
1100 Yoice YLAN Site Specific Option Number (SSON) (232 &
1100 Voice YLAN IDs
IPO-SMet Firewall | <hones v
RTP Keepalives
Scope RTP V| Periodic timeout 110
Initial keepalives |Enabled bl
| v
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set the Binding Refresh Time (seconds) to 60. This value is used as one input to determine
the frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider. (Refer to Section 5.10)

e Set Public IP Address to the IP address of the Avaya IP Office LANZ2 port. Public Port is
set to 5060.

e All other parameters should be set according to customer requirements.

Ei IPOffice_1*

System || LAN1 | LaNZ | DNS Yoicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning

LAN Settings | ¥oIP | |Metwork Topology| | SIP Registrar

Metwork Topology Discovery

-~

STUN Server IP Address | 192 . 168 . 10 . 13 | STUNPart (3478 3

Firewall{NAT Type iOpen Internet v
Binding Refresh Time 60 |
(seconds) L x

Public IP Address | 10 10 93 14 |
Public Port 5060 & Run STUN Cancel

[C] rRun STUN on startup

In the compliance test, the LANL interface was used to connect the Avaya IP Office to the enterprise
site IP network. The LANL1 interface configuration is not directly relevant to the interface with
Windstream SIP Trunking service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details Pane. Choose the Companding Law
typical for the enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the
service provider across the SIP trunk. Set Hold Timeout (secs) to 600.

Ko

= POffice e | X | v =]
System :LANI LANZ | DNS Yoicemail | Telephony | | Directory Services | System Events | SMTP | SMDR || Twinning | ¥CM | CCR || Codecs
|| [Tefephony] | Tones & Music | Call Lag
A~
Analogue Extensions Companding Law -
s — Switch Line

Default Outside Call Sequence 1 Ny{rgql R

Default Inside Call Sequence ;ana ﬂ;ail v © U-Law Line

Default Ring Back Sequence Rln Type 2 v/

i 2 kil —= O Alaw O a-LawLine

Restrict Analogue Extension Ringer Yoltage []
Dial Delay Time (secs) ;4 C} [] D35 Status
Dial Delay Count ‘U = i Auto Hold
Default No Answer Time (secs) |15 73\ Dial By Name
Hold Timeout (secs) ‘670707 73‘ Show Account Code
Park Timeout {secs) §3ﬁ0 3 i ID Inhibit OFf-Switch Forward,l'TransFerl
Ring Delay (secs) 5 2 | [[] Restrict Network Interconnect
Call Priority Promation Time (secs) Disabled = [[] prop External Only Impromptu Conference
Default Currency [usp 3| [[] visually Differentiate External Call
Default Name Priority :7Favor Trunk 3| [ Unsupervised Analog Trunk Disconnect Handling

o High Quality Conferencing
9|
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5.3. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of
other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the Twinning tab, as shown below. The second
parameter is the Send Caller ID parameter on the SIP Line form (shown in Section 5.4).

If Send original calling party information for Mobile Twinning on the Twinning tab is optioned,
the setting of the second parameter is ignored and Avaya IP Office will send the following in the SIP
From Header:
e On calls from an internal extension to a twinned phone, Avaya IP Office will send the calling
party number of the originating extension.
e On calls from the PSTN to a twinned phone, Avaya IP Office will send the calling party
number of the host phone associated with the twinned destination (instead of the number of
the originating caller).

If this option is unchecked, the value sent in the SIP From header is determined by the setting of the
second parameter mentioned above.

e For the compliance test, the Send original calling party information for Mobile Twinning
box in the System—>Twinning tab was unchecked. The value sent in the SIP From header is
determined by the setting of the Send Caller ID parameter on the SIP Line form.

IPOffice_1

| System | Lant | LANZ | DNS | voicemail | Telephony | Directory Services | System Events | sMTP | SMDR vem | ccR | Codecs|

[[:] Send original calling party information For Mobile Twinning ‘

Calling party information for
Mobile Twinning
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5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Windstream SIP

Trunking service. To create a SIP line, begin by navigating to Line in the left Navigation Pane, then
right-click in the Group Pane and select New - SIP Line. On the SIP Line tab in the Details Pane,
configure the parameters as shown below:

e Set ITSP Domain Name to the enterprise domain so that IP Office uses this domain as the
host portion of the SIP URI in SIP headers such as the From header.

e Check the In Service box.

e Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.

e Set Call Routing Method to Request URI.

e Check Caller ID from From header box.

e Set Send Caller ID to Diversion Header. For the compliance test, this parameter was used
for call forwarding and it was used in Mobility Twinning since Send original calling party
information for Mobile Twinning is not optioned in Section 5.3.

e Set Association Method to By Source IP address.

e The area of the screen entitled REFER Support is used to enable/disable SIP REFER for

call transfers. The default values of “Auto” for Incoming and Outgoing effectively disable
the use of SIP REFER.

e Default values may be used for all other parameters.

IP Offices Line E

& BOOTP (8)
% Operator (3)
=39 IPOffice_1

39 System (1)
)]

“ Control Unit (4)
A Extension (29)

§ User(2m)

% HuntGroup (1)
8% short Code (58)
@B service (0)

o RAS (1)

€9 Incoming Call Route (5)
9 wanport (0)

@ Directory (0)

1) Time Profile (0)
@ Firewall Profile {1)
ER 1P Route (3)

&m Account Code (0)
&, License (30)

& Tunnel (0)

§3 User Rights (10)
@ Auto Attendant (0}
‘¢ ARS (2)

fix E911 System (1)

Line Mumber = Line Type

Line SubType

1 PRI 24 {(Universal) T1

2 PRI 24 {(Universal) T1
.17 SIP Line

SIP Line - Line 17* f

SIP Line| Transport | SIP URI YoIP | T38 Fax| SIP Credentials

Line humber 17 -

’lTSP Domain Name |10.10.98.14

I In Service

Prefix
National Prefix
Country Code

International Prefix

Use Tel URT

Check 005

| Call Routing Method

Request URI v

Originator number For
forwarded and twinning calls

Name Priority
Caller ID from From header

Send From In Clear

User-Agent and Server
Headers

‘ Send Caller ID Diversion Header

<

Inssociation Method | By Source IP address

<

REFER Support
Incoming | Auto

Outgoing Auto

UPDATE Supported | Mever

Sygtem Default v
O
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Select the Transport tab. The ITSP Proxy Address is set to the Windstream SIP proxy gateway IP
address provided by Windstream. As shown in Figure 1, this IP address is 192.168.49.125. In the
Network Configuration area, UDP is selected as the Layer 4 Protocol, and the Send Port is set to
the port number provided by Windstream, in this case the well known SIP port of 5060 was used.
The Use Network Topology Info parameter is set to LAN 2. This associates the SIP Line with the
parameters in the System - LAN2 - Network Topology tab. Other parameters retain default
values in the screen below.

& BOOTP(8)
¢ Operator (3)
=)=y IPOffice_1

%3y System (1)
|
<= Control Unit {4)
A& Extension (29)
2 User(2n)
#% HuntGroup (1)
B3¢ Short Code (58)
B service (0)
o RAS (1)
@ Incoming Call Route (S)
@ WanPort (0)
@ Directory (0)
£ Time Profile (0)

IP Offices Line Ei

SIP Line SIP URI|voIP | T38 Fax|SIP Credentials

Line Number  Line Type Line SubType

o1 PRI 24 {Universal) T1

-2 PRI 24 (Universal) T1
{17 SIP Line

|nsp Proxy Address |192.168.49,125

SIP Line - Line 17*

Metwork Configuration
Layer 4 Protocol UDP

Use Network Topology Info  |LAN 2

SendPort 5060

<

Calls Route via Registrar

Separate Reqgistrar

Explicit DNS Server(s) | 0 1] o || o a o 0 |
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A SIP URI entry must be created to match each incoming number that Avaya IP Office will accept
on this line. Select the SIP URI tab; click the Add button and the New Channel area will appear at
the bottom of the pane (Not shown). To edit an existing entry, click an entry in the list at the top, and
click the Edit... button. In the example screen below, a previously configured entry is edited. For
the compliance test, a single SIP URI entry was created that matched any DID number assigned to
an Avaya IP Office user. The entry was created with the parameters shown below:

e Set Local URI, Contact and Display Name to Use Internal Data. This setting allows calls
on this line whose SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.6.

e Set PAI to None.

e Set Registration to 0: <None>.

e Associate this line with an incoming line group in the Incoming Group field. This line group
number will be used in defining incoming call routes for this line. Similarly, associate the
line to an outgoing line group using the Outgoing Group field. For the compliance test, a
new incoming and outgoing group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

B SIP Line - Line 17 et
SIP Line || Transport |[SIP URI vaIP T38 Fax| SIP Credentials
‘ Channel = Groups Via | Local URI Contact Display Mame PAI Credential Max Calls 1 Add...
1 17 17 b MN... 0: <Non... 10
Remaove
Edit...
Edit Channel
Via 10.10.95.14
Local URI bse Internal Data v
Contact ) Jse Internal Data v/
Display Mame lse Internal Data v
PAI fione] >
Reqistration D <None> v
Incoming Group 17
Outgoing Group 17
Max Calls per Channel [10 =
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Select the Vol P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. Selecting G.729(a) 8K CS —
ACELP and G.711 ULAW 64K codecs causes Avaya IP Office to include these codecs,
which are supported by the Windstream SIP Trunking service, in the Session Description
Protocol (SDP) offer, in that order.

e Set Fax Transport Support to G.711 from the pull-down menu.

e Set the DTMF Support field to RFC2833 from the pull-down menu. This directs Avaya IP

Office to send DTMF tones using RTP events messages as defined in RFC2833. Windstream

also support DTMF Inband.

Uncheck the VolP Silence Suppression box.

e Check the Re-invite Supported box.
e Check Use Offerer’s Preferred Codec.
e Default values may be used for all other parameters.
=] SIP Line - Line 17 ek -
|SIP Line | Transport | SIP um;r 738 Fax| SIP Credentials i ]
Codec Selection f-Custom v/ [] voIP Silence Suppression
Unused Selected Re-invite Supported
[G.711 ALAW 64K | a5 | ||&.729(a) 8K C5-ACELP ]
|G.723.1 6K3 MP-HLQ G711 LLAW 64K Use Offerer's Preferred Codec
‘ [[] codec Lockdown
S [[] prack/100rel Supported
Fax Transport Support g;;l 0 \;
Call Initiation Timeout {s) 4 c
DTMF Support RFC2833 |
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5.5. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation Pane, then right-click in the Group Pane and select New. On the Short
Code tab in the Details Pane, configure the parameters for the new short code to be created. The
screen below shows the details of the previously administered “6N;” short code used in the test
configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 6N;, this short code will be invoked when the user dials 6 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@192.168.49.125”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@” is the domain of the service
provider network.

e Setthe Line Group ID to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound
call.

e Set Locale to United States (US English).

IP Offices Short Code B 6N;: Dial
R BOOTP(8) Code Telephone Number | Feature X |
1/ Operator (3) PAHITHNE N Call Queue
=%y IPOffice_1 Px*3dn; N Hold Music Code 6N
39 System (1) WXRITHE N Extn Login = - |
4 Line (3) B35 Extn Logout Fealure Dl el
“=» Control Unit (4) PUFITNE N Call Park Telephone Number  |N'@192.168.49.125"
& Extension (29) P*3BIE N UnPark Call :
i User (27) Bx*ag 1 Relay On Line Group ID |17 ¥
2 8*40 1 Relay OFf Locale [United States {Us English) |-
- Px+41 1 Relay Pulse
% ze.qrsw(cf)(o) Pr+4z 2 Relay On Force Account Code  []
@ Incoming Call Route (5) 843 2 Relay OFf
@ WanPort (0) B 44 2 Relay Pulse
s Directory (0) m N'@192.168.49.... Dial
£ Time Profile (0) SN N Dial
@ Firewall Profile (1)
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The simple “6N;” short codes illustrated above does not provide a means of alternate routing if the
configured SIP Line is out of service or temporarily not responding. When alternate routing options
and/or more customized analysis of the digits following the short code are desired, the Automatic
Route Selection (ARS) feature may be used. In the following example screen, the short code 9N is
illustrated for access to ARS. When the Avaya IP Office user dials 9 plus any number N, rather than
being directed to a specific Line Group ID, the call is directed to Line Group ID 50: Main,

configurable via ARS. See Section 5.8 for example ARS route configuration for 50: Main as well as
a backup route.

B mou

| Short Code
Code 9N
Feature | Dial v

Telephone Mumber N

Line Group ID jSO: Main v |

Locale jUnited States (US English) v
Force Account Code [
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is H323 4525. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4). The
example below shows the settings for user H323 4525. The SIP Name and Contact are set to one of
the DID numbers assigned to the enterprise from Windstream. The SIP Display Name (Alias)
parameter can optionally be configured with a descriptive name. If all calls involving this user and a
SIP Line should be considered private, then the Anonymous box may be checked to withhold the
user’s information from the network.

IP Offices

& BOOTP (8)
& Operator (3)

% IPOFfice_1

=3 System (1)

17 Line (3)

= Control Unit (4)
& Extension (29)
i

% HuntGroup (1)
8% short Code (58)
@B service (0)

H323 4525: 4525

Mame Extension
FAX 4527 4527
smhoUser
f#mRemoteManager

frsp as2e 4526

Yoice Recording | Button Programming | Menu Programming | Mobility | Phone Manager Options | Hunt Group Membership | Announcements | Personal Directory

SIP Name 8642634525

SIP Display Name (Alias) |H323 4525

Contact 8642634525

[[] Anonymous
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323 4525. The Mobility Features and Mobile Twinning
boxes are checked. The Twinned Mobile Number field is configured with the number to dial to
reach the twinned mobile telephone, in this case 616139675205. Other options can be set according

to customer requirements.

[] 1nternal Twinning

Twin Bridge Appearances

Twin Line Appearances
|

‘ I Mobility Features I
Mobile Twinningl

Twin Coverage Appearances

Telephony ‘3 Forwarding | Dial In || Yoice Recording ‘ Button Programming | Menu Programming ‘

H323 4525: 4525*

Mobility Phone Manager Options

HV; Reviewed:
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Twinned quile Number 616139675205
(including dial access code) - ""TTTTTTTT |
Twinning Time Profile [(None:» ™
Mobile Dial Delay {secs) EVZW . B B 77 :
Mobile Answer Guard (secs) ,07 ; éi
[] Hunt group calls eligible for mobile twinning
[] Forwarded calls eligible For mobile twinning
[ Twin When Logged Out
[] one-% Mobile Client
[] mMoabile Call Control
Mobile Callback
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5.7. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in
the center Group Pane and select New. On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.

e Setthe Line Group ID to the incoming line group of the SIP line defined in Section 5.4.
e Set the Incoming Number to the incoming number on which this route should match.

e Set Locale to United States (US English).

e Default values can be used for all other fields.

IP Offices Incoming Call Route | (8 17 8642634525
R BOOTP (8) Line Group ID | Incoming Nurber | || [Standard] | voice Recording | Destinations
4/ Operator (3) @0 e

=%y IPOffice_1 e 17 8642634527 = —
“39 System (1) 17 8642634526 Bearer Capability | Any Yoice bl
1 Line (3) 17 8642634525 o =

4- Control Unit {4) @ Line Group ID |17 v/

& Extension {29) Incoming Mumber 8642634525
$ User(2?) s T
% HuntGroup (1) Incoming Sub Address [
#3 Short Code (58)
B service (0) Incoming CLI [
o RAS Q) Locale 37Llnited States {US English) v 1
Q Incoming Call Route (4) _— —
€8 wanPart (0) Priority : 1-Low v
2% Directory (0) -
£ Time Profile (0) Tag
@@ Firewall Profile (1) : B |
@l 1P Route (3) Hold Music Source |System Source. R |
&m Account Code (0)

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to 8642634525 on line 17 are routed to extension
4525 H323 4525.

= 17 8642634525

| Standard | Yoice Recordingj L I
TimeProfile Destination
4 | Default Value 4525 H323 4525 v
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5.8. ARS and Alternate Routing

While detailed coverage of Automatic Route Selection (ARS) is beyond the scope of these
Application Notes, this section includes basic ARS screen illustrations and considerations. ARS is
shown here mainly to illustrate alternate routing should the SIP Line be out of service or temporarily
not responding.

Optionally, ARS can be used rather than the simple 6N; short code approach documented in Section
5.5. With ARS, a secondary dial tone can be provided after the access code, time-based routing
criteria can be introduced, and alternate routing can be specified so that a call can re-route
automatically if the primary route or outgoing line group is not available. Although not shown in this
section, ARS also facilitates more specific dialed telephone number matching, enabling immediate
routing and alternate treatment for different types of numbers following the access code. For
example, if all 1+10 digit calls following an access code should use the SIP Line preferentially, but
other local or service numbers following the access code should prefer a different outgoing line
group, ARS can be used to distinguish these call behaviors.

To add a new ARS route, right-click ARS in the Navigation pane, and select New. To view or edit
an existing ARS route, select ARS in the Navigation pane, and select the appropriate route name in
the Group pane.

The following screen shows an example ARS configuration for the route named Main. The In
Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the
form. If the In Service box is un-checked, calls are routed to the ARS route name specified in the
Out of Service Route parameter. IP Office short codes may also be defined to allow an ARS route
to be disabled or enabled from a telephone. The configurable provisioning of an Out of Service
Route, and the means to manually activate the Out of Service Route can be helpful for scheduled
maintenance or other known service-affecting events for the primary route.

IP Offices ARS -9 [ X| v <]
&R BOOTP (8) Narne: Time Profile e
@ Operator (3) ¢ backup =
=1 % IPOffice_t ARS Route Id Secondary Dial tone
3 System (1)
7 Line (3) Route Name SystemTone v
<> Control Unit {(4)
& Extension (29) Dial Delay Time System Default (4) & Check User Call Barring
2 user(27)
2% HuntGroup (1)
BE: o o] InService Out of Service Route 51: backup v
@ service (0) -
A& RAS (1) 1
@ Incoming Call Route (4)
£ wanPort (0) Time Profile e Out of Hours Route <Monez> A
s Directory (0) l
£ Time Profile (0)
Firewall Profile (1)
Qo s T Fesrs ireen
&m Account Code (0) 1 911 Dial Emergency 0
S License (30) 911 s11 Dial Emergency 0 Bels
W Tunnel (0) on; 0N Dial 31 0 =
3 User Rights (10) in; 1N'10.10.98.14" Dial 31 17
8 Auto Attendant (0) X N Dial 31 0
N KRRIXKRKAN N Dial 3K1 0
§i% EST1 System (1)
Alternate Route Priority Level |3 v l
Alternate Route Wait Time |30 $|——————+ Alternate Route 51: backup v 3
[ ok J[ concel ][ heb
HV; Reviewed: Solution & Interoperability Test Lab Application Notes 21 of 28

SPOC 6/19/2013 ©2013 Avaya Inc. All Rights Reserved. WSSIPTrkSOIPO81




Assuming the primary route is in-service, the number passed from the short code used to access ARS
(e.g., 9N in Section 5.5) can be further analyzed to direct the call to a specific Line Group ID. Per
the example screen above, if the user dialed 9-1-613-967-5205, the call would be directed to Line
Group 17, the SIP Line configured and described in these Application Notes. If Line Group 17
cannot be used, the call can automatically route to the route name configured in the Additional
Route parameter in the lower right of the screen. Since alternate routing can be considered a
privilege not available to all callers, IP Office can control access to the alternate route by comparing
the calling user’s priority to the value in the Alternate Route Priority Level field.

The following screen shows an example ARS configuration for the route named backup with ARS
Route ID 51. Continuing the example, if the user dialed 9-1-613-967-5205, and the call could not be
routed via the primary route 50: Main described above, the call will be delivered to this backup
route. Per the configuration shown below, the call will be delivered to Line Group 1, using an analog
trunk connecting the Avaya IP Office to the PSTN as a backup connection. In this case, the
originally dialed number (sans the short code 9) will be dialed as is through the analog/PRI trunk to
the PSTN.

IP Offices

R BOOTP (8)
4 Operator (3)
“ IPOffice_1

% System (1)
1 Line (3) Route Name backup SystemTone v
“= Control Unit (4)
& Extension (29) Dial Delay Time System Default (4) 4 Check User Call Barring
§ Userizn

&% HuntGroup (1)

9% Short Code (58)

@ service (0)

o RAS (1)

€ Incoming Call Route (4) a
£ wanPort (0) Time Profile ey Out of Hours Route | <None> v

E

ARS

Time Profile

RS Route Id E Secondary Dial tane

In Service Out of Service Route <None> v

o Directory (0)
£ Time Profile (0) l
g ;',' Z:z!; g;“a L Code Telephone Number Feature Line Group ID. -m
&m Account Code (0) 11 911 Dial Emergency 0

S License (30) 911 911 Dial Emergency 0 Remove
@& Tunnel (0) N N Dial 0
£ User Rights (10)
8 Auto Attendant (0)
¢[ERs )]

fix E911 System (1)

ey fltErRate RoUte <Mone> v 2

Help
|

In the testing associated with the configuration, calls were successfully delivered to SIP Line 17 via

the primary ARS route 50: Main or to the analog/PRI trunk via the backup ARS route shown above.
When the primary route experiences a network outage, Avaya IP Office successfully routed the call

via the backup route.
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5.9. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling party
number in the From and Contact headers of the SIP INVITE message with “restricted” and
“anonymous” respectively and enable privacy:id. On the other hand, by default Avaya IP Office will
send the P-Preferred-ldentity (PPI) or can be configured to use the P-Asserted-Identity (PAI) header
to pass the actual calling party information for authentication and billing. For the compliance test,
Windstream does not use either PP1 or PAI for the purposes of privacy.

5.10. SIP OPTIONS

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection is
active. The rate at which the messages are sent is determined by the combination of the Binding
Refresh Time (in seconds) set on the Network Topology tab in Section 5.1 and the
SIP_OPTIONS_PERIOD parameter (in minutes) that can be set on the Source Number tab of the
noUser user. The OPTIONS period is determined in the following manner:

e Ifno SIP_OPTIONS PERIOD parameter is defined and the Binding Refresh Time is 0,
then the default value of 44 seconds is used.

e To establish a period less than 42 seconds, do not define a SIP_OPTIONS_PERIOD
parameter and set the Binding Refresh Time to a value less than 42 secs. The OPTIONS
message period will be equal to the Binding Refresh Time.

e To establish a period greater than 42 seconds, a SIP_OPTIONS_PERIOD parameter must
be defined. The Binding Refresh Time must be set to a value greater than 42 secs. The
OPTIONS message period will be the smaller of the Binding Refresh Time and the
SIP_OPTIONS_PERIOD.

To configure the SIP_OPTIONS_PERIOD parameter, navigate to User > NoUser in the
Navigation / Group Panes. Select the Source Numbers tab in the Details Pane. Click the Add
button.

IP Offices NoUser:
K 20‘]:;2;23) User | Voicemai 1| DND | ShortCodes Telephony | Forwarding | Dial In | Voice Recording | Button Programming | Menu Programming | Mobility | Phone Manager Options | € »
Remove

S | Uniit (4)

& Extension (29) Edit..

i

3 FuntGroup (1)
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At the bottom of the Details Pane, the New Source Number field will appear. Enter
SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

1
ﬁ NoUser: * ek -E | X[ v|<]>
| User Woicemail | DND | ShortCodes | Source Numbers :VTeIephonry Forwarding Dial In | Voice Recording | Button Programming | Menu Programming | Mobility | Phone Manager Options < ’7
v Source Number Add...
Remove
Edit...

New Source Number

.

Source Number SIP_OPTIONS_PERIOD=2

The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown
below. For the compliance test, an OPTIONS period of 1 minute was desired. The Binding
Refresh Time was set to 60 seconds (1 minute) in Section 5.1. The SIP_OPTIONS_PERIOD
was set to 2 minutes. Avaya IP Office chose the OPTIONS period as the smaller of these two
values (1 minute).

IP Offices NoUser: k- X|v<]|>

R BOOTP (8) Mame Extension
% Operator (3) frFax 4527 4527
2 IPOffice_1 H323 4525 4525
29 System (1)
£ Line (3)
< Control Unit (4)

User | voicemai i | DND | ShortCodes | [Source Numbers || Telephony | Forwarding | Dial In | Yoice Recording | Button Programming | Menu Pragramming | Mobility | Phone Manager Options | ¢ »

e
SIP_OPTIONS_PERIOD=2

FaRemoteManager
#rsipas2e 4526

& Extension (29)
i

% HuntGroup (1)
8% Short Code (58)

5.11. Save Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Windstream SIP Trunking Configuration
Windstream is responsible for the configuration of Windstream SIP Trunking service. The customer
must provide the IP address used to reach the Avaya IP Office at the enterprise. Windstream will
provide the customer the necessary information to configure the SIP connection between Avaya IP
Office and Windstream. The provided information from Windstream includes:

e Fully Qualified Domain Name, IP address and port number used for signaling or media

through any security.
e DID numbers.
e Windstream SIP trunking Specification.
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7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start - Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State for each channel
(The below screen shot showed an active call at present time).

AVAYA

ogOff Exit  About

Peer Domain Name:
Resolved Address:

Line Number:

Number of Administered Channels:
Hurnber of Channels in Use:
Administered Compression:

Silence Suppression:

SIP Trunk Channel Licenses:

SIP Trunk Channel Licenses in Use:

SIP Device Features:

Status | Utilization Summary: Alarms

33 IP Office RB.1 System Status - IPOffice_1 (10.10.98.14 ) - IP500 V2 8.1 (43)

IP Office System Status

EEX

SIP Trunk Summary

10.10.98.14
192.168.49.125

G711 Mu, G729 A
OfF

Unlimited
p— . »
1

Direction of Fln:w‘uruj Trip Receive Ji Transmit Jitter T
ts Call Delay. 3 P:
1 0 57 Connected 00:00:29 |192.168.49.124 |G711 Mu| RTP Relay [Extn 4525, H323 4525 Outgoing ;
2 Idle 23:37:43
3 Idie 5 days 03:4...
4 Idle 5 days 03:4...
S Idle S days 03:4...
6 1die 5 days 03:4...
7 1die 5 days 03:4...
8 1die 5 days 03:4...
8. Idle 5 days 03:4...
10 Ide S days 03:4...
Help IR PM
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. Select the Alarms tab and verify that no alarms are active on the SIP line.

3 1P Office RB.1 System Status - IPOffice_1 (10.10.98.14) - IP500 V2 8.1 (43) EX

IP Office System Status

Alarms for Line: 17 SIP 10.10.98.14

IP Networking

Pl s )

e Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

8. Conclusion

Windstream SIP Trunking passed compliance testing. These Application Notes describe the
procedures required to configure the SIP connection between Avaya IP Office and the Windstream
SIP Trunking service as shown in Figure 1.

9. Additional References

[1] IP Office 8.1 Installation, Document number 15-601042 Issue 26j, 19 Sep 2012

[2] IP Office 8.1 Manager 10.1, Document number 15-601011 Issue 290, 03 Aug 2012

[3] IP Office 8.1 Administering Voicemail Pro, Document number 15-601063 Issue 27b, 05 June
2012

[4] IP Office Embedded Voicemail User Guide (IP Office Mode), Document number 15-604067
Issue 12a, 26 Feb 2013

Product documentation for Avaya products may be found at: http://support.avaya.com. Additional IP
Office documentation can be found at;
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Windstream SIP Trunking may be found at:
http://www.windstreambusiness.com/equipment/cpe/documents
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are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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